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1 In-Application Support Overview 
The Player deployment format that is published from the Developer is not only useful in 
various training and educational initiatives; it is also designed to provide in-application support 
for end users. 
  
There are specific add-ons and instructions for certain major enterprise applications to 

accommodate context-sensitive in-application support; these applications are referred to as 
target applications throughout this document. Content can generally be deployed using one or 
both of the following methods, depending on the target application: 

 Help Integration: The users invoke the context-sensitive content using a button or an 
entry in the target application's menu. This requires the application administrator to 
make minor configuration changes in the target application. 
   

 SmartHelp: SmartHelp also offers in-application support for non-target browser 

applications where help integration may not be a viable option. SmartHelp can be used 
for target and non-target applications and offers additional advantages. SmartHelp, 
which is tightly integrated in the browser, allows users to open a sidebar showing the 

best matches for the currently displayed page in the application. In addition to offering 
support where help integration is not possible, SmartHelp can handle multiple content 
locations for multiple applications. Using this component, users can access and search 
multiple content sources with a single action. SmartHelp requires installation of a 
browser add-on, which may require the help and approval of Information Technology 
resources. 

1.1 Plan for Deploying In-Application Support 
Once you decide to deploy content for in-application support, some of the fundamental 
questions that need to be addressed are: 

 What deployment mechanism is most appropriate for your application, Help 
Integration with a target application, SmartHelp-based deployment, or both? 
  

 Who needs to be involved, what needs to be done, and when does it have to happen?  

Understanding the answers to these questions will give you the information you need to 
implement help integration and context-sensitive help successfully.  

  
These are the tasks which need to be completed to successfully deploy in-application support. 
  
Content Author 

 Create content in the Developer: While context for many applications will be 
automatically captured, it is recommended that you validate that context is being 

captured. You can check this by opening the topic in the Topic Editor and then opening 

the Context ID editor. If the Type field displays SmartMatch or ExactMatch, context 
was captured. If it displays NoMatch, no context was captured. In addition, while you 
are recording a topic, there is an icon in the Recorder which shows context recognition 
status. 
  

 Create an IAS Configuration document in the Developer: Consult with the application 

and content web server administrators to find out the necessary URLs. 
  

 Give the published content to the web server administrator, or publish the content to 
Knowledge Center. 

Web Server Administrator 
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 Deploy the published content to a web server. 

Application Administrator 

 Perform the configuration steps detailed in this guide for each application. 

   

 Receive the content URL from the web server administrator. If the content has been 
published and deployed to the web server, the iasinfo.html page in the deployed 
content can be launched to get the URLs which must be configured on the server. 

   

 Perform help integration steps for URL configuration, if applicable. 

Test User 

 Verify the published content appears from the application using the Help Integration 
option or SmartHelp. 

If you are deploying context-sensitive help, the test user should coordinate with the content 
developer to note which parts of the application were used to create content and then verify 
that the content launches with an appropriate list of relevant topics. 

1.2 Target Application Configuration and Content Creation 
For most target applications, application configuration can occur after and independently of 
content creation, if the exact path to the content, including the folder and name of the 
gateway, is known in advance. There are exceptions:  

 Oracle E-Business Suite: It requires library files to be installed on the application 
server (applcore forms server) before recording content. See Implement Context-
Sensitive Help Integration in the Oracle E-Business Suite section later in this guide for 

more information on installing library files for Oracle E-Business Suite. 
  

Note: Oracle E-Business Suite 12.1.2 no longer needs the library files; however, you 
should add a profile in the System Profile form. 
  

 PeopleSoft Enterprise: It is recommended that PeopleBooks be installed and 

configured before starting to record content. You can also use the hosted PeopleBooks 
from Oracle, but it must be configured to have the Help link displayed which is 
required for recording content. 
   

 Oracle Fusion Applications: Oracle User Productivity Kit must be registered in Fusion 
before content can be recorded. 

If you want to deploy context-sensitive help, always check that context is being captured while 
recording. See Context Recognition in the Recorder in the Record and Edit Topic Content 
chapter of the Content Development guide for more information on capturing context while 
recording. 
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2 Implement In-Application Support 
End users access in-application support in one of two ways. The first is via a help link, button, 
or menu item in the target application. This option is called help integration and requires an 
application administrator to make minor configuration changes in the target application to 
enable the Player context-sensitive help. The second option, called SmartHelp, is to install a 
browser add-on. This may require the help and approval of your Information Technology 

resources.  
  
The SmartHelp browser add-on provides context-sensitive in-application support for enterprise 
applications as well as comprehensive search across multiple sources, that is, Players. It can 
search sources only to which the user is subscribed. When it detects where the user is in the 
application, it provides the user with help topics tailored specifically for the current browser 
page from the available sources.  

  
Applications supported by:  

  
SmartHelp only  
  
Oracle (Siebel) CRM On Demand  

Oracle Transportation Management  
Any browser-based application with HTML user interface (as long as the browser/version is 
supported by SmartHelp)  
  
Help Integration only  
  
JD Edwards World  

SAP GUI for Windows  
  
SmartHelp and Help Integration  
  
Agile CNM  

Agile PLM  
JD Edwards EnterpriseOne  

Oracle E-Business Suite (SmartHelp not supported for Oracle Java Forms)  
Oracle (Hyperion) EPM 
Oracle Fusion Applications  
Oracle Knowledge Center  
PeopleSoft  
Primavera P6  

Primavera Contracts Management 
SAP GUI for HTML 
SAP NetWeaver Portal  
Siebel CRM (On Premise High Interactivity and Open UI Applications)  
  
Refer to the following information for the general steps to implement SmartHelp and/or Help 
Integration. Details about each step are in the following sections. 

  
Implement SmartHelp  

 Create content in the Developer and create an IAS Configuration document for the 
content. See Configure Content for more information. 
   

 Install SmartHelp by deploying a link or pushing it to the end users. See Install 

SmartHelp for more information. 
   

 Publish the content and deploy it on a web server or publish it to Knowledge Center. 
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 SmartHelp recognizes it as a possible source and offers it for subscription. After the 
source subscribed, it is used by SmartHelp in the search. 

Implement Help Integration  

 Create content in the Developer and create an IAS Configuration document for the 

content. See Configure Content for more information. 
   

 Publish content and deploy it on a web server or publish it to Knowledge Center. 

   

 Integrate help into the target application by adjusting settings in the target application 
to launch the content. See the appropriate section for your application in Integrate 
Help for Target Applications. 

2.1 Configure Content 
Whether you are configuring content for SmartHelp or help integration or both, you use IAS 

Configuration documents in the Developer. These documents contain options that allow you to 

associate the configuration with specific content, control launch behavior, and set up rules for 
the context search. The configuration document is dynamic; as you select options other 
options may be hidden or may appear. 
  
A configuration document can be stored anywhere in the Library. It is recommended that the 
configuration be stored in the same folder as the root outline item, and when saved, saved 

with the same name as the root outline item. This makes it easier to select the correct 
configuration document when the content is published. Also, the configuration document is not 
automatically selected as a related document if you export the outline into an odarc. If the IAS 
Configuration document is stored in the same folder as the root outline item, the document 
and the outline item can be easily selected to be exported together. 
  
In an IAS Configuration document, you create a configuration and associate it with content in 

the Library. When you publish the content, you select the IAS Configuration document in the 
Publishing Wizard, and the appropriate files are published with the content. 

  

To create a new IAS Configuration document: 

1. Open the Developer. 

   
2. On the File menu, point to New and choose IAS Configuration. 

Configuration Overview 

When you create a new configuration document, there are two main sections, Sources and 
Application Instances. The Sources section allows you to "enable" content for use with 
SmartHelp and define different types of content for help integration. The Application Instances 

section allows you to configure specific applications to use SmartHelp and/or Help Integration, 
and define which Sources can be used for either one.  
  

The examples below are for different situations to help you understand how the options in a 
configuration document relate to each other. Each example assumes you have started by 
creating a new configuration document. Refer to the sections that follow for more information 
about each of the options in the Configuration document. 

  
Example 1: Configure a single application for SmartHelp. 

1. In the Sources section, choose the Player content in the Library and be sure that the 

Allow SmartHelp option is selected. If you are deploying the content on web server 
and not through Knowledge Center, enter the URL where the content is deployed. 
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2. In the Application Instances section, choose the application from the Type list, enter a 

name, and select the source from those available in the SmartHelp Sources list. 

   
3. Define the SmartHelp URL Rules. 

Example 2: Configure a single application or multiple applications to use multiple SmartHelp 
sources. You can define as many SmartHelp Sources as you need for an application. 

1. In the Sources section, choose the Player content in the Library and be sure that the 

Allow SmartHelp option is selected. If you are deploying the content on web server 
and not through Knowledge Center, enter the URL where the content is deployed. 
   

2. Still in the Sources section, add a new source, choose the Player content, and enable it 
for SmartHelp. Repeat for as many different outlines as you need. 

   
3. In the Application Instances section, choose the application from the Type list, enter a 

name, and select the sources in the SmartHelp Sources list. 

   
4. Define the SmartHelp URL Rules. 

   

5. If you want to configure multiple applications, add a new application and repeat steps 
3 and 4. 

Example 3: Create a configuration document for an application that supports help integration. 

1. In the Sources section, define a source or sources as necessary. Content can be from 
the current Library, content from another Library, the original application help (for 

certain applications), or any URL, although one of the sources must be Player content 
from the current Library. 
   

2. In the Application Instances section, choose the application from the Type list, enter a 
name, and select the Help Integration option. 

   

3. For the first tab for the integrated help, choose a Player content from the current 
Library. 
   

4. If desired, segment the content, for example for different languages. 
   

5. Add tabs or links as desired to include additional sources of help, such as more 
Players, the original application help, or any URL. 

2.1.1 Sources 

The Sources section in a configuration document allows you to define sources, including the 
content and the type of deployment. There are four types of sources: 

 Player content in this library: Content created in the current library and linked in an 
outline. This type of source is required for SmartHelp. 

   

 Player published from another library: Content created in a different library, published 

to a Player and deployed on a web server. 
   

 Original application help: Applies to Oracle Help, PeopleBooks for PeopleSoft, and 
Siebel Help only. 

   

 Any URL: Any URL on the Internet or company intranet that users can access. 

A new configuration document opens with an empty source so that you can specify the first 
one. You should always specify at least one source that is Player Content in this Library. This 
associates the IAS Configuration document with content so that it can be published. For 
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SmartHelp, you must specify Player content in the current library. All other types of sources 
are for help integration. You can have multiple sources, so you can add configurations to 
include different types of content as needed. 

  

To add a new source: 

1. In a configuration document, click the add new link in the Sources section. 
   

2. In the Type list, select the type of content. 

The options vary, depending on the type of content you select. The sections below detail the 

options. 
  
Player Content in This Library 
  
No options can be set for this type of source until you select content. 

 Title: The Select Outline button opens the Select Outline dialog box so you can 
browse the library and select the content. 

   

 Caption: Use this option to specify a shorter, user-friendly name for the content 
outline you chose. This shorter name is used on the gateway tabs and link menu if you 
set up help integration. 

   

 Language: The language defaults from the content you chose. 
   

 Description: The description defaults from the Description property of the module or 

section you chose. 
   

 Deployment Type: Allows you to specify whether the content is deployed through 

Knowledge Center or a web server. 
   

 Deployed Content URL: This field appears if you select Web Server as the 

deployment type, and it is a required field. Enter the URL that can be used to access 
the content on the web server. 
   

 Allow SmartHelp: Allows you to specify whether this content appears in the 

SmartHelp sidebar. Allows you to select the content as a source for SmartHelp for an 
application. Also causes the Global Settings for SmartHelp section to appear. 
   

 Public Subscription URL: This field only appears if you select web server as the 

deployment type and SmartHelp is allowed. It is only required if the content is 
deployed behind authentication. Enter the full URL from which the user can subscribe 
to the content so that it appears in the SmartHelp sidebar. The URL should end in 
cdd.html. The cdd.html should be from the published Player, copied to a publicly 
available location. 
   

 Export Player Configuration: Exports the gateway and configuration files that you 

need for help integration and SmartHelp. The output should be copied into a 
previously published Player. This option allows you to export the configuration files 
without having to republish the content. It only appears if you have selected Web 
Server as the deployment type. 

Player Published from Another Library 

 Title: The title for the source. This title should be the same as the title of the external 

Player. This is used as the title of the window in the browser when the Player is 
launched through the gateway when using help integration. 
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 Caption: Use this option to specify a shorter, user-friendly name for the content 

outline you chose. This shorter name is used on the gateway tabs and link menu if you 

set up help integration. 
   

 Deployed Content URL: Use this option to specify the URL to the root folder of the 

content; for example, http://<server name>/<content folder>. Enter a path, not a 
specific page. 

Original Application Help 

 Application Help Type: Use this option to specify the type of application help: Oracle 
Help, PeopleBooks, or Siebel Help. 
   

 Caption: Use this option to specify a shorter, user-friendly name for the content 
outline you chose. This shorter name is used on the gateway tabs and link menu if you 
set up help integration. 
   

 URL: Enter the URL to the location from where the Oracle application help or 
PeopleBooks can be launched. The URL is not needed for Siebel help. 

Any URL 

 Caption: Use this option to specify a shorter, user-friendly name for the content 
outline you chose. This shorter name is used on the gateway tabs and link menu if you 
set up help integration. 

   

 URL: Enter the URL to the page you want to launch. 

2.1.2 Application Instances 

The Application Instances section allows you to configure the applications and connect them 
with the sources you configured in the Sources section. The options vary, depending on 

whether the application supports SmartHelp only, SmartHelp and Help Integration, or help 
integration only. See Implement In-Application Support for a list of applications.  

  
In the Type list, there are two non-specific application options listed: Browser Application and 
Custom Application. A browser application is exactly that - an application that runs in a 
browser window. This type of application is only enabled for SmartHelp. A custom application 
is one that you have created using the SDK. It may be available for either or both SmartHelp 
and Help Integration. 

 Type: Choose the application type from the list. 

   

 Name: Enter a user-friendly name for the application instance. 
   

 Application Namespace: This option only appears if you selected Custom Application 

from the Type list and your application implements the In-Application Support SDK. 

This is the name created in the SDK when context-sensitivity was created. It should be 
in the form of app.<namespace>, for example app.com.example.MyApplication. See 
the In-Application Support SDK guide for more information. 

Options for SmartHelp-Enabled Applications 

 SmartHelp Sources: This is list of sources that have been enabled for SmartHelp in 

the Sources section. Select the sources to be automatically searched by SmartHelp 
when the user is working with this application instance. 
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 SmartHelp URL Rules: Specify the URL of the server for the application. If there are 

multiple URLs, you can add new ones as needed. See SmartHelp URL Rules following 
this section for more information.  

Options for Applications that Support Help Integration 

These options allow you to configure a gateway page that launches when a user clicks the 
Help link. You can also configure the gateway page to give the user access to additional 
resources, such as the original help for the target application, additional Player packages, or a 
URL to another web site. See application sections for application specific configuration options 
and configuration steps. 

 Default Player: This is the Player that launches if you do not configure the gateway 

page. If you configure any kind of content segmentation, such as multi-language 
support, it only applies to this Default Player, not to Players launched from other tabs 
or links. It also specifies the source so that the configuration for this application is 
published when the outline referred to by the source is published. 
   

 Segment Players: These options allow you to configure the help to launch the 

appropriate content if you have developed content in multiple languages, called 
segmentation. For each Segment Player, you choose the content from the list and then 
specify a language code. The language codes you use should match the ones used by 
the application. Some applications may have additional options. 
  

Note: The list is searched in the order you specify, and the first matching Player is 
launched. 
   

 Help Integration Additional Tabs: Allows you to create more tabs in the gateway 

page to display other Players, the original application help, or the target of a URL. 
Choose the source from the Tab 1 list. Use the add new link to add a tab, and a new 
Tab option appears in which you can choose the source for that tab. 
   

 Remember Active Tab: If this option is selected, a cookie is placed on the user's 

system so that the gateway page launches with the tab that was active when the user 

last accessed it. 
   

 Help Integration Additional Links: You can create links as well as tabs. Tabs are 

opened in an iFrame inside the gateway page, while links open a new window. Links 
are needed when a page does not allow being embedded in a page and must be 
opened in a standalone window. In the Link Menu Title field, enter the name of the link 
menu text to appear on the gateway page. From the Link 1 list, choose the source for 
the link. Use the add new link, and a new Link option appears in which you can choose 
the source for that link. 

2.1.3 SmartHelp URL Rules 

SmartHelp URL Rules allow you to define if this source is applicable for a specific page or 
pages. A URL matches the rule if there is at least one pattern which is matching and the last 

matching pattern in the list was "allow". Rules are evaluated in the order of definition. It is a 

good idea to define the more general patterns first, followed by the more specific patterns. 
You can also specify negative rules to indicate that the source is not available for the page or 
pages. The URLs that begin with "-" are excluded. 
Some things to know as you are defining rules:  

 The URL pattern is case-insensitive. 
   

 The rules support the asterisk (*) wildcard, which matches an arbitrary number of 
characters. A trailing asterisk is always appended to the pattern by default if not 
present (that is we match the URL prefix). 
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 Specifying the protocol in the URL is optional. The protocol (http/https) can be 

anything if not explicitly set. 

   

 It is recommended but not required that the URL pattern specifies at least the host or 
domain name.  

Examples of patterns for rules: 
  
http://*.sampledomain.com/* - any hosts in the domain 
http://host/* - host used without domain 
http://192.nn.nn.nn/* - host used with IP address, where nn.nn.nn are the specific numbers 
in the address 

http://host.mydomain.com/* - exact host name 
http://host.mydomain.com:8080/* - host on specified port 
host.mydomain.com – host only 
*.mydomain.com – domain only 
http://host.mydomain.com/app/*/hr/ - sub-region of a specific application 

  
Negative rules can be useful when the rules are setup generally to include more URLs, and 

then you want to exclude specific URLs. 
  
Example: 
host/app* 
-host/app_one 
  

You need to specify only these two rules instead of specifying the individual instances, such 
as: 
  
host/app_two 
host/app_three 
host/app_four 

2.1.4 Global Settings 

There is a third section of the configuration document called Global Settings. It contains 

options for SmartHelp and Knowledge Center deployments. 
  
SmartHelp 
These options only appear if at least one of the sources is enabled for SmartHelp. 

 Contact: This field is optional. This information appears to the user on the SmartHelp 
subscriptions page. You can enter the name, email, or other contact information for 
the user if they have questions or problems. 

   

 Install Location: This is the default installation location for SmartHelp. You can set 
the default for this in the Options dialog box. If a user does not have SmartHelp 
installed on their system, the Player suggests that the user install it from this location. 

   

 Export SmartHelp Installer: This exports the SmartHelp Installer and its related 
files, as well as an html page that can be used as the target for users to download and 
install SmartHelp. 

Knowledge Center 
This option only appears if at least one of the sources has a deployment type of Knowledge 

Center. 

 Content Root URL: Enter the URL for the content root in Knowledge Center. This URL 
appears on the Server Properties page in Knowledge Center Manager, but you need to 
make a change to this URL to use it. When specifying the content root URL in the 
configuration, it should end with "Titles" instead of "Content" (which is what appears 
on the Server Properties page). You need to specify the Titles folder instead of the 
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Content folder because the GUID based aliases in Knowledge Center are handled in 
the Titles folder rather than the Content folder. For example, if the Server Properties 
page displays http://KCenter-host/KCenter/Content, you would need to enter 

http://KCenter-host/KCenter/Titles in the configuration. 

 
In most cases, this field is optional. When the configuration must be copied to the 
application server and the content is deployed on the Knowledge Center server, this 
field is mandatory. 

2.2 Integrate Help in Target Applications 
If help integration is available for a target application, there is some configuration that must 
be done on the application server. This section outlines the configuration for each target 
application. 

2.2.1 Agile CNM 

Agile CNM can be configured to launch context-sensitive help through the Help button. When 

the user clicks the Help button, the Player help launches directly or a gateway page appears 
allowing the user to choose between the Player help and the Agile CNM help.  
 
A System Administrator can configure the Agile CNM application to launch the context-
sensitive Player help from the Administration link inside the application. 
 

To configure Agile CNM: 

1. Log in to the Agile CNM application. 
  

2. Click the Administration link. 

  
3. Click the System Settings link. 

  
4. Click in the Online Help URL field. 

  
5. Change the URL to point to the agilecnm_gateway.html file inside the Player Package. 

  
Example: http://<server>/<path>/agilecnm/hemi/agilecnm_gateway.html 
  

6. Click Save. 

2.2.2 Agile PLM 

Agile PLM can be configured to launch context-sensitive help through the Help button. When 
the user clicks the Help button, the Player help launches directly or a gateway page appears 
allowing the user to choose between the Player help and the Agile PLM help.  
 
You configure the Agile PLM application to launch the context-sensitive Player help directly 

from the Help button by using the Java client interface for administration.  
 

Note: For customers using Agile Pharma inside version 9.3.1, a server side configuration is 
necessary to configure the help link to launch Player content. The file name is CFMConfig.xml 
and is located under <Agile_Home>\AgilePharma\config. In this xml file, locate the 
<AgileHelpUrl> variable and configure it to point to the Player Package. Below is an example:  
 
<AgileHelpUrl>http://<server>/<path>/agile/hemi/agile_gateway.html</AgileHelpUr

l>  

  

To configure Agile PLM:  

1. Log in to the Agile Java client application. 
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2. Click the Admin tab. 

   

3. Expand the Server Settings item in the tree. 
   

4. Double-click the Locations item in the tree. 
   

5. Click the Online Help Manuals URL field. 

   
6. Enter the server and virtual directory where the published Player content is located, 

for example: 
  
http://<server>/<path>/agile/hemi/agile_gateway.html 
   

7. Click the Close button. 

   
8. Click the Yes button.  

2.2.3 JD Edwards EnterpriseOne 

In the P98MOQUE file, update the Helps path to point to the pste1_gateway.html file in the 
/psentone/hemi folder. This path should be a URL path based on your virtual directory 
setup. 
   
For example: 

http://<server>/<path>/psentone/hemi/pste1_gateway.html  
  
It is a good idea to make a note of the original PeopleBooks help URL in case you want to use 
it later. 
  
Starting with Tools 9.14, add a new MOQ record via P98MOQUE using the Queue Name "UPK" 
and a Type of "12". 
 

Note: While setting up the Media Object Queues you may use Help Content as the Queue 
name and point to pste1_gateway.html file under ..\psentone\hemi in the published content 

folder as the On-Line and Off-Line Queue paths. 

2.2.4 JD Edwards World 

The instructions that follow are for the JWalk Java client interface. A button to launch Player 
content appears on the program menus; no configuration is necessary for this button to 
appear. However, it must be configured to point to the Player help content through entries in 

two text files.  
  
To launch the context-sensitive help content, the JD Edwards World Web Enablement 
administrator needs to set entries appropriately in the WV9100.JVM and DYNBLD9100.JVM 
text files. These files are located within the Deployment area of the JWalk server or client. 

 For the iSeries-i5 Installation: 
www/<HTTP server>, such as apachedft/htdocs/JWALK/JWALKAPP/A9100APP 

  

 For the Windows NT-2000-2003 Server Installation: 
C:\Inetpub\wwwroot\JWALKAPP\A9100APP or 
C:\Program Files\Apache Software 
Foundation\Apache2.2\htdocs\JWALKAPP\A9100APP 

The Text File entries to be updated are: 

 UPKVIEWI: Set this to Y to display the Context aware icon on the program menus. 
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 UPKVIEWH: Set this to Y to display the View Content Option from the Help Drop Down 

menu. 

  

 UPKHELP: This displays text when hovering over the Context aware icon. 
  

 UPKHELPOPT: This displays text for the option on the Help Drop Down menu. 
  

 UPKPath: This should be set to the path of the content location. For example: 

  
http://<server>/<path>/jdeworld/hemi/jdeworld_gateway.html?CTXEX= 

If you place the help content on the Windows server supporting the JWalk client interface, no 
additional configuration is necessary. If the help content is on a non-Windows server, you 
need to configure the odcustomurl.js file. 

2.2.5 Oracle E-Business Suite 

To implement Help Integration for Oracle E-Business Suite, you must install and compile two 

library files that are delivered with the Developer installation. To complete the integration, 
modify the HELP_WEB_AGENT profile on the Oracle server to point to the Player content. This 

causes the Player interface to launch directly from the Oracle Help menu. 
 
Implement Context-Sensitive Help Integration 
If you want to implement context-sensitive help for Oracle E-Business Suite applications, the 
correct Context IDs of the objects in Oracle must be captured while the content is recorded. To 
enable this in Oracle E-Business Suite 12.1.1 or earlier, you must deploy or modify the custom 
library (CUSTOM.pll) on the Oracle server you use to record the content. This must be done 

before you begin to record content. To enable this in Oracle E-Business Suite 12.1.2 or later, 
you can add an entry in the System Profile form. 
 
Enable Context Recognition in Oracle E-Business Suite 12.1.2 or Later 
In Oracle E-Business Suite 12.1.2 or later, you add a profile in the System Profile form. 
 

To enable context recognition in Oracle E-Business Suite 12.1.2 or later: 

1. Launch the Oracle E-Business Suite application. 
  

2. Click the System Administrator link. 

  
3. Click the Profile>System link to launch the System Profile form. 

  
4. Enter %UPK% in the Profile field. 

  
5. Click the Site field and change the value to Yes to enable context recognition. 

This change is available to all users in the E-Business Suite application. 
  

6. On the File menu, click Save. 
  

7. On the File menu, click Exit Oracle Applications and click OK. 

Enable Context Recognition in Oracle E-Business Suite 12.1.1 or Earlier 
To enable context recognition, you must either deploy a custom library or modify an existing 
one, and then modify the HELP_WEB_AGENT profile. The custom library is required for 
recording content only. It is not necessary for deployment of context-sensitive content from 

Oracle E-Business Suite. If you use the different systems for development (content creation) 
and production (deployment), then the custom library configuration is not necessary in the 
production environment. If you use the same system for development and production, then 
custom library only needs to be installed while the content is being recorded. 
  
Check Existing Custom Library Configuration 
The .pll delivered with the Developer is written with SPECIAL7 as the default value. This 
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default value is a suggestion. You can use anything between 1 and 15. If you have not created 

any Oracle specific applications that use the SPECIAL event, you can use the default. If you 

have created Oracle-specific applications that do use the SPECIAL event, the value of 7 may 
be taken, and you need to find another suitable unused value between 1 and 15. 
  
You can use the following command lines to find an unused value instead of editing and 
recompiling the custom.pll file repeatedly: 

 
cd $AU_TOP/forms/US; grep -i APP_SPECIAL.ENABLE `find . -name "*.fmb" -print`| grep 
SPECIAL7| grep -i PROPERTY_ON 
cd $AU_TOP/resource; grep -i APP_SPECIAL.ENABLE `find . -name "*.fmb" -print`| grep 
SPECIAL7| g rep -i PROPERTY_ON 
 
If you receive a result that looks like the statement below, the value is already being used. 

 
./CSCCCCRC.fmb:app_special.enable('SPECIAL7', PROPERTY_ON); 
 
Deploy a Custom Library 

Use the following steps if you have not deployed a custom Library on your Oracle Applications 
server. 
 

To deploy a custom library: 

1. Back up your existing CUSTOM.pll to CUSTOM.pll.orig. 
  

2. Locate the ODPNCustomPLL.zip file in the ORACLE folder where the Developer is 
installed and extract the CUSTOM.pll and ODPN.pll files. Copy them to the 
$AU_TOP/resource folder on the Oracle Applications server. 
  
Note: $AU_TOP is defined as a variable and references 
/oracle/VIS/apps/apps_st/appl/au in both a Unix and Windows operating system. 
  

3. Ensure that no one is currently using Oracle Applications (Web Forms). Shut down the 

Oracle Forms Server service if you are running 11i. 
  
Note: It is not necessary to shut down any service if you are running R12. 
  

4. While in the $AU_TOP/resource, compile the ODPN.pll and CUSTOM.pll library files 

using the command for your specific EBS version: 
  
Oracle 11.5.10 server: 
ifcmp60 module=ODPN.pll module_type=LIBRARY userid=apps/apps@<instance> 
compile_all=yes 
  
ifcmp60 module=CUSTOM.pll module_type=LIBRARY userid=apps/apps@<instance> 

compile_all=yes 
  
For Oracle E-Business Suite R12: 

frmcmp module=ODPN.pll module_type=library userid=apps/apps@<instance> 
compile_all=yes 
  
frmcmp module=CUSTOM.pll module_type=library userid=apps/apps@<instance> 

compile_all=yes 
  
Note: Replace the database connect string to reflect your instance. 
  
Note: Shutting down the Forms server is not necessary for Oracle E-Business Suite 
R12. 

Modify an Existing Custom Library 
Use the following steps if you have custom logic in your custom library (CUSTOM.pll) that you 
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do not want to overwrite. You must place a line of code in the custom library that will call out 
to a new library (ODPN.pll). After doing this, you will only need to recompile your existing 
CUSTOM.pll if you receive new versions of ODPN.pll with software upgrades. 

 

To modify a custom library: 

1. Back up your existing CUSTOM.pll to CUSTOM.pll.orig. 
  

2. Copy the CUSTOM.pll from the $AU_TOP/resource folder on the Oracle Applications 
server to a client machine that has Oracle Forms Builder installed. 
  

3. Copy the APPCORE2.pll from $AU_TOP/resource folder on the Oracle Applications 
server to a client machine that has Oracle Forms Builder installed. This should be the 
same folder you used for the previous step. 
  

4. Locate the ODPNCustomPLL.zip file in the ORACLE folder where the Developer is 
installed and extract the ODPN.pll file. Copy it to the client machine into same folder 

as previous file copies. 
  

5. Open CUSTOM.pll using Oracle Forms Builder and attach ODPN.pll. Place this file in 
the same folder on the client side as your CUSTOM.pll prior to the attachment. 

  
6. Answer Yes when asked to remove directory path. 

  
7. Add the following code to the Event procedure: 

  
gkod_event (event_name, 'SPECIAL7'); 
  

Note: You may use any number between 1 and 15 in the SPECIAL command as long 
as there are no conflicts. See Check Existing Custom Library Configuration for more 
details. Beginning with Oracle EBS 12.1, the SPECIAL command can be replaced with 
the MENUX command where X is a number between 1 and 15. 
  

8. Ensure that no one is currently using Oracle Applications (Web Forms). Shut down the 
Oracle Forms Server service. 

  
9. Copy the CUSTOM.pll and ODPN.pll files from the client to the $AU_TOP/resource 

folder on the Oracle Applications server. 
  

10. Compile both the ODPN.pll and the CUSTOM.pll files using steps 5 and 6 in the 
previous section. 

Modify the HELP_WEB_AGENT Profile 
You must modify the HELP_WEB_AGENT profile in Oracle to point to the oracle_gateway.html 
in the Player content deployed on the server. 

  
Note: It is a good idea to make a note of the original help URL in case you want to use it 
later. 

  
For Oracle E-Business Suite 11i , the URL consists of two parts: the path for the 
oracle_gateway.html file located in the \oracle\hemi folder in the Player content, plus the path 

of the default dbc file for the Oracle server. 
  
Following is an example for 11i: 
 
URL=http://<server>:<port>/oracle/hemi/oracle_gateway.html?dbc=d:\oracle\o11iappl\fnd\
11.5.0\secure\<server name>.dbc 
 

Following is an example for R12: 
 
URL=http://<server>:<port>/oracle/hemi/oracle_gateway.html 
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To modify the HELP_WEB_AGENT profile in Oracle E-Business Suite: 

1. Sign on to the Oracle EBS Application via the web browser as an administrator. 
  

2. Click the System Administrator link and locate the System Profile. 
  

3. When the java form launches, enter APPLICATIONS_HELP% in the Profile field and 
click Find. 
   

4. Enter or edit the URL with the path to the oracle_gateway.html. 
  

Note: For Oracle 11.5.10, include the location of the .dbc file in the URL string. Once 
you have completed your changes, stop and restart the Oracle Forms service. 
  

5. For the profile change to take effect in the current session, exit from the Oracle 
application and sign in again. 

  
6. Click Help in Oracle, and the Player launches. 

2.2.6 Oracle (Hyperion) EPM 

Player help can be launched through the Help menu for supported Oracle (Hyperion) EPM 

applications. For the Calculation Manager, EPM Architect, Financials Management, and 
Planning applications, the help is context-sensitive. For the Smart View and Financial 

Reporting Studio applications, the help is not context-sensitive.  
  
The help launch for all supported applications is controlled through an option in the Hyperion 
Workspace Server Settings. When you enter a URL in the field, the Oracle User Productivity Kit 
option appears on the Help menu automatically. Note that if the field is blank, the Oracle User 
Productivity Kit may still appear as an option for certain applications such as Financials 
Reporting Studio, but the option is grayed out and unavailable.  

  

To configure the help menu: 

1. Launch and log in to the Hyperion Workspace. 
   

2. On the Navigate menu, choose Administer. 
   

3. Click the Workspace Server Settings menu. 
   

4. In the URL to User Productivity Kit field, enter the URL to the content location. The 
URL should consist of the web server name and the virtual directory where the content 

is located. For example, http://<server>/<path>. You do not need to append any 
further information. 
  

5. Click OK twice to close the Workspace Server Settings dialog box and save your 
settings.  

  
6. Log off and on to the Hyperion Workspace to apply the URL change. 

2.2.7 Oracle Fusion Applications 

Users can take advantage of Oracle User Productivity Kit (UPK) content while working with the 
Oracle Fusion Applications. To make Oracle UPK content available for users, you need to 

enable and configure the UPK link under the Help menu of Oracle Fusion Applications (11g 
Release 7 and higher). 
  
To perform this task, you must have the role of a System Administrator and have relevant 
privileges on the environment where you want to enable and configure the UPK link. 
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Registering Oracle UPK as an Enterprise Application 

The Oracle User Productivity Kit must be registered in Fusion before content can be recorded. 

To complete the configuration, the System Administrator must have security access to use 

Oracle Functional Setup Manager. 
  

To register UPK as an enterprise application: 

1. On the Oracle Fusion Applications Home page, select Navigator, Tools, Setup and 

Maintenance to access the Setup and Maintenance work area. 
   

2. In the Setup and Maintenance work area, under Topology Objects, click the Manage 
Enterprise Applications link. 
   

3. Click the Register Enterprise Applications link. 

   
4. Click Add to register Oracle UPK to the Oracle Fusion applications. 

   

5. In the Basic Information section, define your Enterprise Environment, Enterprise 
Application and the Name of the registration. 
   

6. Select your Enterprise Environment from the list. 

   
7. Use the Search link in the list to search for your Enterprise Application. 

   
8. In the dialog box, enter or select Oracle, and click Search. 

   
9. In the Search results, select Oracle User Productivity Kit from the list and click OK. 

   
10. In the Basic Information section, in the Name field, enter Oracle User Productivity 

Kit as the registration name. 
   

11. In the Server Details section, configure the Server Protocol that you are using to 
launch your content. 

  

Note: The Player supports both http and https protocols. 
   

12. In the External Host field, enter the full DNS name of the server host. 
  
Example: content.server.com 
   

13. In the External Server Port field, enter the appropriate port for either http or https. 

  
Note: The default port for http is 80. The default port for https is 443. 
   

14. In the Context Root field, enter the directory location where the Player is to be 
deployed. 
   

15. Click Save and then click Close. 

After you complete the preceding configuration steps, check the Help menu on the Oracle 

Fusion Applications to verify that the “Oracle User Productivity Kit” link is now available as a 
menu item. 
  
You may upload content in the specified location (part of the UPK Registration in Fusion FSM) 
and check to validate that the player launches with context sensitivity. 

2.2.8 Oracle Knowledge Center 

To implement help integration for Oracle Knowledge Center, replace the pre-existing help for 
each language, as desired. The help systems are located in a Help folder within the location 

where the Knowledge Center is installed. In a default installation, the location is: 
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C:\Program Files\User Productivity Kit\Knowledge Center\Web Server\KCenter\Documentation 

 
Within the Help folder, there is a folder for each language, designated by a two-letter code, for 
example, EN for English and DE for German. Within each language folder, there are three 
folders, each containing one of the help systems for the Knowledge Center: 

 KCenter: The help for the main user interface. 

  

 Manager: The help for the Manager application, which launches when a user clicks the 
Manager link in the Navigation pane. 
  

 Reports: The help for the Reports application, which launches when a user clicks the 
Reports link in the Navigation pane. 

Each folder contains a Player package. Copy the Player package with your customized help 
into the appropriate folder. For example, to replace the default help with customized help for 

the Knowledge Center main interface in English, go to this folder: 
 

C:\Program Files\<brand>\Knowledge Center\Web 
Server\KCenter\Documentation\EN\Help\KCenter 
 
Note: It is highly recommended that you zip the existing Player package as a backup before 
you copy the customized package. 

2.2.9 PeopleSoft 

The Player supports two methods of configuration for the Web Profile helpurl configuration, 
local or hosted PeopleBooks. To properly record context IDs in a PeopleSoft application, you 

must set the HelpURL field inside your active Web profile configuration to point to the 
pst8_gateway.html file, and append the context parameter string that makes up the URL.  
  
Whether you choose to use a local version of PeopleBooks or a version hosted by Oracle, you 

must configure the HelpURL field to point to the published PlayerPackage and use the 
appropriate query string of parameters based upon your choice. 
  

Local PeopleBooks configuration: 
http://<server>:<port>/<path>/pst8/hemi/pst8_gateway.html?ContextID=%CONTEXT_ID%
&LangCD=%LANG_CD% 
   
Hosted PeopleBooks/Universal Linking configuration: 
http://<server>:<port>/<path>/pst8/hemi/pst8_gateway.html?id=%CONTEXT_ID%&ctx=<fi
rst value>&ctx=<second value>&LangCD=%LANG_CD% 

 
Note: For additional information about hosted PeopleBooks, see the PeopleBooks Online 
Library at: 
  
http://docs.oracle.com/cd/E17566_01/epm91pbr0/eng/psbooks/psft_homepage.htm 
 

Use an IAS Configuration document in the Developer to configure a link in the Player gateway 
page for PeopleBooks; for example, http://www.oracle.com/pls/topic/lookup. 

2.2.10 Primavera Contracts Management 

The Primavera Contracts Management application can be configured to display a User 
Productivity Kit link in the page menu. To configure this feature, the system administrator 
must use the Primavera Administrator tool.  
  

To configure the Primavera Contracts Management application to display the User 

Productivity Kit link:  
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1. Launch the Primavera Administrator tool. 

   
2. Expand the User Productivity Kit folder. 

   

3. Change the Enable User Productivity Kit setting to true. 
   

4. Enter the server and directory location on your web server in the User Productivity 
Kit URL setting. 
   

5. Save the settings. 
   

6. Restart the Weblogic web services.  
  
Once the web server restarts, the new link appears in the page menu. 

2.2.11 Primavera P6 

Primavera P6 can be configured to launch context-sensitive help through the Tutorials link in 

the Help menu. When the user clicks the Tutorials link, the Player help launches. You can 
create your own custom content and point the Tutorials link to it. 
 

To configure the Tutorials link to launch your custom content: 

1. Launch the Administrator tool. 

  
2. Expand the Primavera P6 Configuration folder in the Custom folder. 

  

3. Expand the Application folder and then the Tutorials folder. 
  

4. Edit the Enable Tutorials field and change it to true, if necessary. 
  

5. Edit the Tutorials URL field to point to the custom content location. You only need to 
specify the server and the virtual directory; for example, http://<server>/<path>. 

  
6. Click Save Changes. 

2.2.12 SAP GUI for Windows and SAP GUI for HTML 

To integrate published help content with SAP GUI clients, you must perform the following 

steps: 
  
Server Setup 
These steps should only be performed once. 

 Register an object in SAP Service Marketplace. 
  

 Copy the transport files to the SAP server. 
  

 Import the transport files into the SAP system. 

  

 Customize the SAP Help menu. 
  

 Edit ABAP code to customize the “help_start” function in SAP to launch the Player. 
  

 Translate the Help menu, although this step is optional.  

Server Configuration 

 Configure the Gateway URL. This step requires configuring the URLs to point the 
content for SAP. 
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Content Configuration 

 Configure content segmentation. 

For the installation, an SAP Service Marketplace user with administration rights is required. In 

the target SAP system, a user with developer rights, registered as a developer, is required. 
  
Register an Object in the SAP Service Marketplace System 
An SAP Administrator or someone who has administrative rights for the target SAP installation 
in the SAP Marketplace must perform this procedure. 
  

Register the following object: "PgmID:R3TR, Object:FUGR, ObjectName:SHL2" and make a 
note of the access key. 
  
Copy the Transport Files to the SAP Server 
The transport file contains two files, Kxxxxxx.nnn and Rxxxxxx.nnn, where x and n will vary, 
depending on the version of the Developer that the transport is from. These files must be 

copied to the SAP server. They are contained in a file called HEMITransport.zip and are located 

in the front folder in the Developer installation. 
  
Note: You will need an unzip utility such as WinZip to unzip the files. 
  
The details for the next steps are in the sections that follow. The procedures may vary, 
depending on your SAP version. Procedures ECC6 are provided as examples. 

2.2.12.1 Import the Transport Files 

The transport files that were copied to the SAP server need to be imported into the SAP 
system. A Basis administrator should perform this step. 
  
All objects in this transport are located in the registered development namespace /ORAUPK/. 

This development namespace ensures that no naming conflicts can arise in your SAP system 
because of the transport. 
  

Note: If you want to check the import logs of the transport, select the Goto menu and then 
the Import History command. A return code 4 (Warning) and below is acceptable.  
  
The previous version of the ORAUPK transport was GKOD. If it was never installed on the SAP 

server, follow the steps below. If the GKOD transport was installed on the SAP server, use the 
steps below, paying special attention to the notes. 
  

To import the transport files to an SAP version ECC6 server: 

1. Log on to SAP as a Basis administrator. 

   
2. In the Transaction Code field, enter stms. 

   

3. Click   Enter. 

   

4. Click   Import overview. 

   

5. Double-click the import queue of the target system. 
   

6. On the Extras menu, point to Other requests and choose Add. 
   

7. In the Transp. request field, enter nnnKxxxxx, where nnn and xxxxx match the name 
of the transport file that was unzipped. 
   

8. Click  (Continue). 
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9. Click Yes. 
    

10. On the Queue menu, choose Close. 

   

11. Select the added transport and click Import Request. 
   

12. In the Target client field, enter the number of the appropriate client. 
   

13. Click  (Continue). 

   
14. Click Yes. 

   

15. Click  (Refresh). 

   

16. Click  (Exit) twice. 

2.2.12.2 Customize the SAP Help Menu 

Once the transports have been imported into the SAP system, you must customize the SAP 

System Help menu to launch Player content by creating a menu item with 'Code' ZOND and 
'Functional Type' H. 
  
Note: If GKOD, the previous version of the transport, was not installed on the SAP server, 
skip the steps as indicated below. 
  

To customize the SAP Help menu on a version ECC6 server: 

1. Log on to SAP as a user with developer rights. 

   
2. In the Transaction Code field, enter se41. 

   

3. Click  (Enter). 

   
4. In the Program field, enter MENUSYST. 

   
5. In the Status field, enter MEN. 

   

6. Click  Change. 

   

7. Click  (Continue) twice to respond to messages in the Menu Painter: Initial Screen 

box. 
  
Note: If the GKOD version of the transport was installed on the server, click Continue 

three times. 
   

8. Click Maint. in orig. lang. 
  
Note: Skip this step if the GKOD version of the transport was NOT installed on the 
server. 
   

9. Click  (Continue). 
  
Note: Skip this step if the GKOD version of the transport was NOT installed on the 

server. 
   

10. Click  next to Menu bar. 
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11. Double-click the Hilfe entry in the list. 

   

12. Click the ERHI entry in the list. 
  
Note: Skip this step if the GKOD version of the transport was NOT installed on the 
server. 
   

13. On the Edit menu, point to Insert and choose Separator line. 
   

14. Click  (Continue). 

   
15. On the Edit menu, point to Insert and choose Entry. 

   
16. In the Code field, enter ZOND. 

   
17. In the Text field, enter the text that you want to use for the menu entry that launches 

the Player. 

  
Note: Skip this step if the GKOD version of the transport was NOT installed on the 
server. 
   

18. Double-click the Code field in which you entered ZOND. 
   

19. In the Functional type field, enter H. 
  
Note: Skip this step if the GKOD version of the transport was NOT installed on the 
server. 
   

20. Click  (Continue). 

   
21. On the Extras menu, choose Active functions in multiple statuses. 

   

22. Click  (Continue). 

   
23. Select all of the options in the Status column. 

  
Note: Skip this step if the GKOD version of the transport was NOT installed on the 
server. 
   

24. Click  Copy. 

   

25. Click  (Activate). 

   

26. Click  (Create request). 

  
Note: Skip steps 26 - 29 if the GKOD version of the transport was NOT installed on 

the server. 
   

27. In the Short description field, enter the desired text. 
   

28. Click  (save). 
   

29. Click  (Continue). 

   

30. Click  twice. 



  Implement In-Application Support 

   23 

2.2.12.3 Customize the HELP_START Function 

In this process, you must edit code to customize the “help_start” function in SAP. This function 

launches SAP Help menu commands and must be modified to launch the Player with special 
parameters. 
  
Note: The status message "Object FUNC_HELP_START is part of the Basis interface; further 
development not allowed" may appear. This message is not an error, and you should continue 
with the procedure. 
  

To Customize the HELP_START function on an ECC6 server: 

1. Log in to SAP with developer rights. 
   

2. In the Transaction Code field, enter se37. 
   

3. Click  (Enter). 

   
4. In the Function module field, enter HELP_START. 

   

5. Click  Change. 

   
6. Enter your user access key and the access key for the object that was registered in the 

SAP Service Marketplace system. 

   
7. Click Continue. 

   

8. Click  (Continue). 

   
9. Click Maint. in orig. lang. 

   

10. Click  (Find/Replace). 
   

11. In the Find what field, enter when 'GLOS'. 
   

12. Click Find Next. 
   

13. Click Cancel. 
   

14. Click in the workspace to position the insertion point before the when 'GLOS' 

statement. 
   

15. Click  Insert. 

   
16. Enter UPK Include and press ENTER twice to create two blank lines under the *UPK 

Include statement. 

   
17. Click the first blank line you just created and enter include 

/ORAUPK/Y_START_UPK. 

  
Note: The period at the end must be included in the statement. 
   

18. Click  (Check). 

   

19. Click  (Activate). 
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20. Click  (Continue) twice. 

   

21. Click  (Exit). 

   

22. Click  (Activate). 
   

23. Click  (Exit). 

2.2.12.4 Translate the Help Menu 

You can translate the SAP menu items into different local languages. The Help menu will then 

appear in the language that the user specified while logging in to the SAP GUI. 
  

To translate the Help menu on a version ECC6 server: 

1. Log in to SAP as a user with developer rights. 

   
2. In the Transaction Code field, enter se41. 

   

3. Click  (Enter). 

   
4. In the Program field, enter MENUSYST. 

   
5. In the Status field, enter MEN. 

   
6. On the Goto menu, choose Translation. 

   
7. Click the Target Language field and enter the language code. 

   

8. Click  (Translate). 

   

9. Click  (Find Text). 

   
10. In the Find field, enter the text that you used for the menu entry that launches the 

Player. 
   

11. Click  (Copy). 

   

12. Click  (Sequential). 

    
13. Enter the menu text in the target language. 

   

14. Click  (Save). 

   

15. Click  (Exit). 

   

16. Click  (Back). 

   

17. Click  (Exit). 



  Implement In-Application Support 

   25 

2.2.12.5 Configure the Gateway URL 

In this process, you configure the help menu entry you created to point to your deployed 

content. The content must be installed on a Web server and the URLs, which can be used to 
access the content, must be entered into the system. 
  
You can set up the URL to call Player content in any client, or you can set up client-dependent 
base URLs. When you enter a Default Base URL and select the Enabled option, the entry is 
used to call Player content in any client by default. If you save the entry with the Enabled 
option deselected, the Default Base URL is not used in the system. If you do not want to use 

the Default Base URL, you must still enter an empty string in the table. If the entry is not 
defined, you receive an error message. 
  
You can create client dependent base URLs as well. If there is no entry in the Client Dependent 
Base URL table for a specific client, the Default Base URL is used for that client. When the 
Enabled option is selected for a client, then the URL for the client is taken as the Base URL. 

When the Enabled option is deselected for a client, then Player content is deactivated in the 
client, and users receive an error message when calling Player content. 
  

You must log in to the SAP system as a user with developer rights. Since the table you use is 
defined as client independent, you can log in to any client to change the entries. 
  

To configure the Gateway URL on a version ECC6 server:  

1. Log in to SAP as a user with developer rights. 

  
2. In the Transaction Code field, enter /n/ORAUPK/SS. 

  

3. Click  (Enter). 

   
4. Click Default Base URL. 

   
5. In the Default Base URL field, enter the URL to the sap_gateway.html page in the 

content for SAP on the web server. This must be a fully-qualified URL containing the 
sap_gateway.html page. 

  
Note: The sap_gateway.html page is located in the front\hemi folder within the Player 
package. 
  
Example: //<server>/Player/front/hemi/sap_gateway.html. 
   

6. Click the Enabled option. 

   

7. Click  (Save). 

   

8. Click  (Continue). 
   

9. Click Client Dependent Base URL. 
   

10. Click  Maintain. 

   

11. Click  (Continue). 

   
12. Click New Entries. 

  
Note: The following steps are for adding a URL pointing to the content that is client-
dependent. These steps configure the SAP system to launch content from a specified 
URL depending on the client number in which the user logged in. You can use any 
valid SAP client number for these steps. You can also use multiple entries for multiple 
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clients. 

   

13. In the Client field in the first row of the table, enter a client number. 
   

14. Click Enabled. 
   

15. In the Base URL field in the first row of the table, enter the path to the 

SAP_gateway.html page in the content for SAP on the web server. 
  
Note: This URL can be different than the one above. 

16. Click  (Save). 

     

17. Click  (Exit) twice. 

   
18. Click Check Configuration. 

   

19. Click  (Exit). 

2.2.12.6 Configure Content Segmentation 

For SAP, you can add parameters in the Application Instance Configuration to segment the 

content by GUI Type and SAP User Parameter in addition to language.  
  

To segment by GUI type and SAP User Parameter: 

1. In the Developer, create an IAS Configuration document. 

  
2. In the Sources section, click Select outline and select the outline with the content 

you created for SAP. In the Caption field, enter a title to show on the tab or link. 
  

3. In the Application Instances section, in the Type list choose SAP Business Suite and 

select the Help Integration option. 

  
4. Select the source you defined in step 2 as the Default Player. 

    
5. To segment the Players, click the add new link under Segment Players. 

   
6. To segment by language, enter the language code used by SAP. 

    

7. To segment by GUI Type, enter S for SAP GUI for Windows, W for SAP GUI for HTML, 
or J for SAP GUI for Java in the Segmentation Parameter field. 
   

8. To segment by User Parameter, enter the User Parameter in the Segmentation 
Parameter field. 
  

Note: To use this parameter for segmentation, the parameter /ORAUPK/Y_ROLE must 
be created in each SAP user's Master Record (transaction SU01). The values in the 

Master Records and the values in the Segmentation Parameter field must match for 
the appropriate content to be returned. 
   

9. Repeat steps 5 through 8 for each language, GUI Type, and SAP User Parameter. 
    

10. Save the IAS configuration document. 

2.2.13 SAP NetWeaver Portal 

This section describes how to integrate content into the Help menu of your SAP NetWeaver 

Portal. The portal administrator or basis administrator needs to perform these steps. 
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Because of the highly configurable nature of the SAP NetWeaver Portal, the steps that you 
must perform may be different than the steps presented here. These instructions assume the 
portal default framework is in use. If another framework is in use, or if the default framework 

has been substantially modified, these instructions may not work. 

  

To display this content in a context-sensitive manner: 

1. Deploy the published Player to a web server in the same domain as the SAP 

NetWeaver Portal or copy the Application Instance Configuration files to the same 
server on which the SAP NetWeaver Portal is deployed. You get the Application 
Instance Configuration files by creating an IAS Configuration document in Developer 
and selecting Export Instance Configuration. See Domain Relaxing in this section for 
more information. 
  

2. Configure the Portal Help Link. 

Deploy the Configuration on the NetWeaver Portal Server 

If the content is published to a server in the same domain as the portal and your NetWeaver 

Portal server is using domain relaxing, it is not necessary to copy the Application Instance 
Configuration files to the NetWeaver Portal server. This is only needed if the Player is deployed 
in a different domain. 
  

To create and export an IAS Configuration document for SAP NetWeaver Portal in the 

Developer: 

1. In the Developer, create an IAS Configuration document. 

   
2. In the Sources section, click Select outline and select the outline with the content 

you created for SAP NetWeaver. In the Caption field, enter a title to show on the tab 

or link. 
  
Note: If you choose Web Server as the deployment type, you must specify the URL 

where you deploy the content. If you choose Knowledge Center as the deployment 
type, the Content Root URL must be set. 
   

3. In the Application Instances section, in the Type list choose SAP NetWeaver Portal 

and select the Help Integration option 
   

4. Select the source you defined in step 2 as the Default Player. 
   

5. Optional: If you are configuring help integration for more than one language, click the 
add new link under Segment Players for each language and specify the appropriate 

language code. 
   

6. Save the IAS Configuration document. 
   

7. Click Export Instance Configuration in the Application Instances section. The files 
that you need are in the exported folder.  

The contents of the sapnwep/hemi folder in the exported Application Instance Configuration 
must be placed at a location that meets the following requirements: 

 It is accessible by HTTP or HTTPS protocols. 

  

 It is on the NetWeaver Portal server, or it is in the same internet domain as your 
NetWeaver Portal server and your server is using domain relaxing. 

For example, if the URL to access your portal is 
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http://netweaverportal.example.com:50000/irj/portal 

 
then the location where you place the gateway and configuration files may be something like: 
 
http://help.example.com:50000/sapnwep/hemi/ 
  

Domain Relaxing 
Domain relaxing is a method of enabling web-based scripting between components that the 
web browser would normally prevent due to cross-domain scripting security concerns. In some 
cases, however, this scripting enables desired functionality. Domain relaxing is designed to 
allow cross-domain scripting between components served from similar root domains (for 
example, content.example.com and server2.example.com). Help Menu Integration for SAP 
NetWeaver Enterprise Portal uses the same domain relaxing technique that SAP uses. 

Additional documentation can be found at: 
http://help.sap.com/saphelp_nw70/helpdata/en/28/7c383f717b5f03e10000000a114084/conte
nt.htm. 
  

If you are using domain relaxing, the Player and the Application Instance Configuration files do 
not need to be separated. No IAS Configuration is necessary unless segmentation is needed. 
You can simply publish and deploy the content, and the gateway files are located in the 

sapnwep/hemi folder. 
  
Configure the Portal Help Link 
The final task in setting up integrated context-sensitive Help for your SAP NetWeaver 
Enterprise Portal is to configure the portal's Help link. The following procedures contain the 
configuration steps for Portal v.7.0 and v.7.4. 

  

For NWEP 7.0, a user with Administration rights can perform the following steps: 

1. Log into the SAP NetWeaver Enterprise Portal. 
  

2. Click the Content Administration tab. 

  
3. In the Portal Content area, expand the Portal Content tree item. 

  
4. Open the Portal Users folder. 

  

5. Open the Standard Portal Users folder. 
  

6. Double-click the Default Frameworks Page to open it. 
  

7. Select the checkbox for the Masthead iView Page Content item. 
  

8. Click the Edit button. 

  
9. In the Property Category drop-down list select Navigation. 

  

10. In the URL of the Help Link field, enter the URL of the sapnwep_gateway.html file. For 
example, the URL you enter may look similar to: 
  
http://help.example.com:50000/sapnwep/hemi/sapnwep_gateway.html 

  
11. Save your changes. 

For NWEP 7.4, a user with Administration rights can perform the following steps: 

1. Log into the SAP NetWeaver Enterprise Portal. 
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2. Click the Content Administration tab. 
  

3. Click the Portal Display tab. 

  

4. Click the Framework Page Configuration hyperlink. 
  

5. Select the Framework page name list box. 
  

6. From the list, select Ajax Framework Page (Ajax Portal Desktop). 
  

7. In the URL of the Help Link field, enter the URL of the sapnwep_gateway.html file. For 

example, the URL you enter may look similar to: 
  
http://help.example.com:50000/sapnwep/hemi/sapnwep_gateway.html 
  

8. Save your changes. 

2.2.14 Siebel CRM (On Premise High Interactivity and Open UI Applications) 
with Server Config 

Note: This method was deprecated and will be removed in the next major release. The 
preferred solution is Siebel CRM (On Premise High Interactivity and Open UI Application) with 
HINT Agent. See the next section for more information on this method. 
  

Content is launched directly from the Contents link from the Siebel Help menu. Siebel Help can 
also be made available on the tabbed gateway as a separate tab or link. This method only 
works for Internet Explorer. 
  
Prerequisites for help integration in Siebel: 

1. Siebel content created in the Developer. 

  
2. A web server to deploy the published content. The content must be published to the 

Player format from the Developer. 
  

3. File level access on the Siebel server to configure the Help menu. The following MIME 
type must be added for the HTTP server on which the Siebel application is hosted. 
Some web servers have this MIME type configured by default. 
  
text/x-component 

Note: In Internet Explorer 9 and 10, the Siebel server URL must be run in compatibility mode 
to display the content in the Player. 

  
Refer to the Technical Specifications for a list of supported versions of Siebel server. 
  

To set up help integration on the Siebel web server: 

1. In the Developer, create an IAS Configuration document. 

  
2. In the Sources section, click Select outline and select the outline with the content 

you created for Siebel. In the Caption field, enter a title to show on the tab or link. 
  
Note: If you choose Web Server as the deployment type, you must specify the URL 

where you deploy the content. If you choose Knowledge Center as the deployment 
type, the Content Root URL must be set. 
  

3. In the Application Instances section, in the Type list choose Siebel CRM (On 
Premise) with Server Config and select the Help Integration option. 
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4. Select the source you defined in step 2 as the Default Player. 

   

5. Optional: If you are configuring help integration for more than one language, click the 
add new link under Segment Players for each language and specify the appropriate 
language code. 
   

6. Optional: If you want to make the original Siebel Help available through help 

integration, go to the procedure below and complete those steps before exporting the 
configuration. 
   

7. Save the IAS configuration document. 
   

8. Click Export Instance Configuration in the Application Instances section. The files 
that you need are in the exported folder. 

  
Note: Export the files to an empty folder to avoid mixing with older files. If there was 
a previous version of help integration configured for the Siebel server, those files 
should be removed from the server. 

   
9. Go to the Siebel application server and find the …/SWEApp/Public/ (installation) folder. 

  

10. Find an application language on the Siebel server for which the configuration must be 
done. Locate the folder with the content you recorded for that language. In the Help 
folder within the content, find and open the Siebhelp.css file and edit it as described in 
the next step. 
  

11. Add the behavior:url command to the body section as indicated below: 

  
body { 

margin-top: 4px; 

margin-bottom: 4px; 

font-family: Verdana, Geneva, Arial, Helvetica, sans-serif; 

font-size: 8pt; 
behavior:url(../hemi/siebel7.htc); 
} 

12. Save the Siebhelp.css file. 

  
13. Locate the /hemi folder in the location to which you exported the configuration. 

  
14. Copy the /hemi folder and paste it in the language folder on the Siebel server. As a 

result, you should have a local path similar to 
../SWEApp/Public/<lang>/hemi/siebel7.htc. 
  

Note: The hemi folder from any previous version should be deleted from the Siebel 
server first. 
  

15. Repeat steps 9 through 13 for every language on the Siebel server for which you want 
help integration. 

To make the original Siebel Help available through help integration: 

1. In the IAS Configuration document in the Developer, click the add new link in the 

Sources section. 
   

2. Click the Original application help link. 
   

3. From the Application Help Type list, choose Siebel Help. 

   
4. In the Caption field, enter a name for the source. This is used as the tab title or link 

text. 
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5. In the Application Instances section, click the add new link under Help Integration 
Additional Tabs or Help Integration Additional Links. 
   

6. From the Tab 1 list, choose the original application help source for Siebel that you just 

created. 
   

7. Save the IAS Configuration document and return to step 8 in the previous procedure. 

2.2.15 Siebel CRM (On Premise High Interactivity and Open UI Applications) 
with HINT Agent 

The following are guidelines for a Siebel Administrator to introduce a new menu item in Siebel 
Applications for the users to launch the Player in a context-sensitive manner. The 
recommended method is to ensure that the solution works as desired in a test environment, 
and then apply the changes to the production environment. 
  
Important Upgrade Note: If you have already implemented this feature using version 

11.1.0.2 and patch 18104838 of this product, then you must repeat all the steps in this 

section for the current solution to overwrite the scripts. Also, the siebel7_ias_agent.html and 
siebel7_ias_agent.js files should be removed from the Siebel server as they are no longer 
needed. 
  
Prerequisites to implement and test help integration in Siebel: 

1. Siebel Tools must be installed and configured. 

   
2. Siebel Web Client is installed with remote access configured on the developer machine. 

   
3. A URL where the Player content will be deployed. This is needed for the menu item to 

launch the Player content. 
   

4. To complete the Siebel server customization steps, the content of the siebel7\agent 
directory is needed from the Developer installation folder. This directory is referenced 

below as <Siebel scripts directory>. 
   

5. Before functional testing of the help integration implementation, the Player should be 
deployed to the web server. 

To add the UPKContentURL property in the Siebel Web Client: 

1. Select Administration - Application in the Site Map. 

  
2. Select System Preferences. 

   
3. Add a new record named UPKContentURL and set the value to the Player content 

URL. Be sure that the URL ends with a slash character. 

To add the service initialization in the Siebel Web Client: 

1. Select Administration - Runtime Events in the Site Map. 

  
2. Select the Action Sets tab of the Runtime Events administration page. 

   
3. Click New to add a new action set and set the name to UPK-Init. 

   

4. Scroll down to the action set records and add a new record with the following 
properties: 
  
Name: UPK-ServiceInit 
Action Type: BusService 
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Sequence: 1 

   

5. Scroll down to the More Info section and set the following fields to the specified 
values: 
  
Business Service Name: UPKService 
Business Service Method: UPKServiceInit 

   
6. Click Menu and Save Record in the More Info section. 

  
7. Select the Events tab of the Runtime Events administration page. 

   
8. Click New to add a new event record with the following properties: 

   

Sequence: 1 
Object Type: Application 
Event: WebLogin 
Action Set: UPK-Init 

   
9. Click Menu and Save Record in the Events section. 

The menu item is created using a Siebel server Business Service and should be applied to the 
Siebel server. 
  

To add the In-Application Support menu item to the Help menu: 

1. Open Siebel Tools and login as a developer. 
   

2. Select menu View/Options... 
   

3. Select the Object Explorer tab in the Development Tools Options dialog. 
   

4. Ensure Command and Menu items are selected in the Object Explorer Hierarchy. 

   
5. Click OK to save the options. 

   
6. Select the Project tree item in the Object Explorer's Types panel. 

   
7. Add a new record to the project list using the Edit/New Record menu. 

   
8. Type UPK in the Project’s Name column; ensure the Locked column is checked. 

   
9. Select Business Service in the Object Explorer panel. 

   
10. Add a new record to business services list using the Edit/New Record menu. 

   
11. Type UPKService in the Business Services' Name column; set the Project to UPK. 

   

12. Open the Business Service tree item in the Object Explorer's Types panel. 
   

13. Select the Business Service Method item. 
   

14. Add a new record to the business service methods using the Edit/New Record menu. 
   

15. Type UPKServiceInit to the Business Service Method’s Name column. 

   
16. Add a new record to the business service methods using the Edit/New Record menu. 

   
17. Type UPKServiceMethod to the Business Service Method’s Name column. 
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18. Right click on UPKService row header in the business services list. 
   

19. Select the Edit Server Scripts menu. 

   

20. Select the File/Import menu and browse for the <Siebel scripts directory>. 
   

21. Select UPKService_ServerScript.js and click Open. 
   

22. Click the Save toolbar button. 
   

23. Right click on UPKService row header in the business services list. 

   
24. Select the Edit Browser Scripts menu. 

   
25. Select the File/Import menu and browse for the <Siebel scripts directory>. 

   
26. Select UPKService_BrowserScript.js and click Open. 

   

27. Click the Save toolbar button. 
   

28. Select File/New Object menu. 
   

29. Select Command in the New Object Wizards dialog. 
   

30. Set command’s associated project to UPK. 
   

31. Type UPKCommand to the command name. 
   

32. Ensure the Browser is selected to handle the command; click Next. 
   

33. Select the Business Service option. 

   
34. Select UPKService in the business services list. 

   

35. Enter UPKServiceMethod in the Method to be invoked field; click Next. 
   

36. Unselect Execute this command in a new window option; click Next. 

   
37. Click Finish. 

   
38. Select the Menu tree item in the Object Explorer's Types panel. 

   
39. Select the Generic WEB Menu project row in the Menus list. 

   

40. Ensure Object Locked column is checked for the selected row. 
   

41. Open the Menu tree item in the Object Explorer's Types panel. 
   

42. Select the Menu Item item. 

   
43. Add a new record to the menu items list using the Edit/New Record menu. 

  
44. Type Help - UPK Sep in the Name column; set the Position to 7.199. 

   
45. Add a new record to the menu items list using the Edit/New Record menu. 

   
46. Type Help – UPK in the Name column; set Caption - String Override to any name at 

your choice to displayed, for example: In-Application Support, Help or Learn; set 
Position to 7.200; set Command to UPKServiceMethod. 
   

47. Navigate to the next record to save the changes. 
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48. The UPKService service must be added to the application. 

  

49. Select menu View/Options... 
  

50. Select the Object Explorer tab in the Development Tools Options dialog. 
  

51. Ensure Application item is selected in the Object Explorer Hierarchy. 

  
52. Expand Application item and ensure that Application User Prop item is selected in 

the Object Explorer Hierarchy. 
  

53. Click OK to save the options. 
  

54. Follow the steps below for all required applications. 

  
55. Select the Application tree item in the Object Explorer's Types panel. 

  
56. Select the required application like Siebel Sales Enterprise for Siebel Sales or Siebel 

Universal Agent for Siebel Call Center, etc. 
  

57. Ensure the Locked column is checked for the selected application. 

  
58. Expand the Application tree item. 

  
59. Select the Application User Prop item. 

  
60. Notice the ClientBusinessServiceX entries in the Name column. 

  
61. Add a new record to the application user props using the Edit/New Record menu. 

  
62. Type ClientBusinessServiceZ in the Application User Prop’s Name column, where Z 

is X+1, where X is the largest number among the ClientBusinessService entries’ end. 
  

63. Type UPKService in the Value column. 

  
64. Step off the record to Save it. 

  
65. Test and verify the changes in the local environment. 

  
66. Check in the menu, UPK and all other locked projects to the server. 

After the previous steps are applied a new menu item called In-Application Support should 
appear in the Siebel Help menu. You can test whether the menu item is functional by 
selecting it and verifying the URL that opens. If the Player content is already deployed to the 

location specified by UPKContentURL, then you can also check that the applicable topics are 
shown. 
  

Language Segmentation 

If you need a solution for multiple languages, then compile and deploy the server changes for 

each language and configure content segmentation in the main Player to which the 

UPKContentURL refers. See Configure Content for more information. 
  

Troubleshooting 

The following message can appear when the user is logged into Siebel Web Client: 

 Unable to create the Business Service 'UPKService'(SBL-DAT-00227) 
The solution must be compiled and deployed to the current Seibel language. 

The following message can appear when a user activates the new menu item in the Siebel 

application: 
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 UPKService: UPKContentURL is not available! 

The message appears when the UPKContentURL property is missing from System 
Preferences. 

2.3 Install SmartHelp 
You can deploy SmartHelp using either a manual installer with a user interface and options 
that the user can select and install, or an unattended installer with no interface based on a 
script that already contains the necessary options to be installed. 
  
In both installation modes, you must have administrator rights to complete the install process. 

2.3.1 Manual Installation with the Installer 

To use the SmartHelp installer, open a command prompt window and navigate to the location 

of the smarthelpinstaller.exe file. You are then prompted to choose the language for the 
Installer, and the Welcome screen appears. During installation, you proceed through these 
screens in the Install Wizard. 

1. Choose Destination Location: You can accept the default target location, or click 

Change to specify a different one. The Destination Location is the target directory 
where the SmartHelp files will be installed. 
  

2. Ready to Install: The Installation Wizard is ready to install the software. Click Back 
to review or modify any settings. 

  
3. Setup Status: This screen appears while the plug-ins are being installed and 

configurations are made to the local workstation to enable SmartHelp. 
  

4. InstallShield Wizard Complete: SmartHelp is installed and can be run through any 
supported browser. 

2.3.2 Unattended Installation 

You can use Push technology to distribute executable files for the setup to user desktops. You 
record response files which contain the pre-determined default settings, and then you can run 
the executable silently. If you deploy executable files in this manner, no interaction is 

necessary on the part of the user. The administrator can control the installation. 
 

2.3.2.1 Record a Response File 

To create a response file, you use the /r parameter to run the setup executable in record 
mode. This generates a response file (.iss) that contains the settings you chose while 

recording. These become the default settings. Recording the installation requires the installer 
to run with the full user interface. 
 
The setup.iss file is stored automatically in the Windows folder. You can use the /f1 option to 
specify a different location in which to create the response file. If the path names contain 
spaces, you must use quotes. The path names should also be absolute, as relative paths may 

have unexpected results. 

 
Example: "<location of the setup file>\smarthelpinstaller.exe" /r /f1"<location of the response 
file>\smarthelpsetup.iss" 
 
Sample: "x:\my folder\smarthelpinstaller.exe" /r /f1"x:\smarthelpsetup.iss" 
 

SmartHelp installation can be performed multiple times, and the configuration can be modified 
for later installations. The first time the installation is recorded for an administrative push 
installation, all the configuration options are stored in a configuration file as noted in the 
command-line parameters. This configuration file can later be edited for subsequent 
administrative push installations and can also be used as the base configuration when 
recording a new configuration for an administrative push installation. 
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To run the executable in record mode for the first time: 

1. Open a Run dialog box and navigate to the location of the smarthelpinstaller.exe 
file. 

   
2. Select the smarthelpinstaller.exe file and click Open. 

   
3. In the Open field, click at the end of the command line. 

   
4. Enter /r /f1<location of the response file>\smarthelpsetup.iss and click OK. 

  

5. Select the language for the installer and click OK. 
   

6. Click Next on the Welcome screen. 
   

7. Select a destination location for the installation. This location is used for all instances 

of SmartHelp when installed using the push installation. Click Next. 

   
8. Enter the URLs for the SmartHelp subscription pages. These URLs should point to the 

registration location (cdd.html) of the SmartHelp source Players. 
  
Example: https://content.example.com/subscription/cdd.html 
   

9. Click Add to add the source to the list. Repeat as necessary to add sources. Select the 

Source URL and click Remove to remove it from the list. 
   

10. Select the Restrict subscriptions to specified URLs only option to prevent the 
users from adding new subscriptions. Click Next. 
   

11. On the Configuration Settings screen, select the user language and the hot keys, and 
click Next. 

  

Note: At minimum, you must select a function key for a hot key. Each browser can 
have its own hot key combination. 
   

12. On the Ready to Install screen, click Install. 
   

13. On the InstallShield Wizard Complete screen, click Finish.  

2.3.2.2 Reconfigure a Response File 

If you have already recorded a response file, you can edit it for subsequent installations or use 
it as a base for a new configuration.  
  
The command-line switch for using an existing configuration is: 
  

/use_config:<previousparameterfile> 
  

where <previousparameterfile> is the location of the previously recorded configuration. 
  
This cannot be the same name as the filename used for recording the new installation (the /f1 
parameter). The installer makes a copy of the original configuration file with this name and 
stores the new settings in a file with the original name. 

  

To reconfigure a response file: 

1. Open a Run window and navigate to the location of the smarthelpinstaller.exe file. 

  
2. Select the smarthelpinstaller.exe file and click Open. 
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3. In the Open field, click at the end of the command line. 
  

4. Enter /r /f1<location of the response file>\smarthelpsetup.iss 

/use_config:<previousparameterfile> and click OK. 

   
5. Select the language for the installer and click OK. 

    
6. Click Next on the Welcome screen. 

  
7. Select a destination location for the installation. This location is pre-populated from 

the previous response file. Click Next. 

  
8. Add or remove the URLs for the SmartHelp subscription pages. These URLs should 

point to the registration location (cdd.html) of the SmartHelp source Players. 
 
Example: https://server/path/cdd.html 
  

9. Click Add to add the source to the list. Repeat as necessary to add sources. Select the 

Source URL and click Remove to remove it from the list. 
  

10. Select the Restrict subscriptions to specified URLs only option to prevent the 
users from adding new subscriptions. Click Next. 
  

11. On the Configuration Settings screen, select the user language and the hot keys, and 

click Next. 
 
Note: At minimum, you must select a function key for a hot key. Each browser can 
have its own hot key combination. 
  

12. On the Ready to Install screen, click Install. 
  

13. On the InstallShield Wizard Complete screen, click Finish. The new installation options 
are recorded in the specified file. 

2.3.2.3 Execute an Unattended Installation 

Once you have recorded a parameter file, you can use the /s parameter to run the setup 
silently. By default, the installation process looks for the response file (.iss) in the same 
directory as the setup.exe. You use the /f1 parameter to specify a different location of the .iss 
file. The response file (.iss) must be either be pushed out with the setup.exe file or reside in a 

location that is accessible to all computers and uses the same drive mapping as is stored in 
the response file. 
 
To run an unattended installation, you must use the standard InstallShield silent install 
parameters in the command line. 
 

/s - runs the installer in silent mode 
 
/f1[scriptfile] - The name of the response file created when running the installer in record 

mode, including the path. 
 
/f2[logfile] - The name of the installation log file created when running the installer in silent 
mode, including the path. This parameter is optional; if it is not used, the log file is created in 

the same folder as the response file. 
 
Example: "<location of the setup file>\smarthelpsetup.exe" /s /f1"<location of the response 
file>\smarthelpsetup.iss" 
 
Sample: "x:\my folder\smarthelpsetup.exe" /s /f1"x:\smarthelpsetup.iss" 
  

While the setup file is running, there is no indication in the task bar. To verify that the setup 
process is still running, open Task Manager and view the Processes tab. Setup.exe should 
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appear in the list. When the smarthelpinstaller.exe disappears from the task list, you can 

verify that the installation was successful by opening the setup.log file and locating the 

[ResponseResult] section. If the value of the ResultCode is 0, the installation was successful. 
  

To execute an unattended installation: 

1. Open a Run window and navigate to the location of the smarthelpinstaller.exe file. 

  
2. Select the smarthelpinstaller.exe file and click Open. 

  
3. In the Open field, click at the end of the command line. 

  

4. Enter /s /f1<location of the response file>\smarthelpsetup.iss /f2<location 
of the log file> and click OK. 

2.3.3 SmartHelp in Knowledge Center 

If you are using Knowledge Center server as the location from which users install SmartHelp, 
you should be aware that when the Knowledge Center server is upgraded, the latest version of 
the SmartHelp Installer is installed on the server. If you do not want to use the new version of 
SmartHelp, you can do two things:  

 Use the SmartHelp Installation Location setting on the Server Properties page in 
Knowledge Center. The Custom URL option allows you to specify a URL to a different 

location. Before you upgrade the Knowledge Center server, you can copy the 
SmartHelp install package from the location indicated in the Knowledge Center URL 
field and copy it to the custom location. Users are then prompted to install the older 
SmartHelp version from the custom location and not the upgraded SmartHelp in the 
location on the Knowledge Center server. 
   

 If you are already using the Knowledge Center Installation Location, copy the 

SmartHelp Installation files from the location and paste them in another location 
before you upgrade Knowledge Center. After you upgrade Knowledge Center, copy the 

new files from the location and store them in another location, then copy the older 
version of the SmartHelp files back on to the server. 

If you deploy SmartHelp content through the Knowledge Center server, and your Knowledge 
Center server runs behind a front-end server such as a web-server, SSL off-loader, load 

balancer, or VPN server, you must configure the server’s external URL so that Knowledge 
Center can resolve URLs properly in the SmartHelp subscription pages. 
  

To configure the Knowledge Center external URL: 

1. Log in to Knowledge Center with an administrator account. 

   
2. Click the Manager link. 

   

3. Point to More and choose Server. 
   

4. Check if the value in the Server URL field is appropriate for your current installation. 
Change the value if necessary. In most cases, this value was set properly during 
Knowledge Center installation. 

2.3.4 Uninstall SmartHelp 

SmartHelp can be disabled in the selected browser using the appropriate Tools menu option 
for disabling the browser add-on.  
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If you want to remove SmartHelp entirely, you can locate the SmartHelp entry in the 
Programs and Features section of the Control Panel and then click Uninstall. You will need 
administrator rights to perform the uninstall process. 

2.3.5 Troubleshooting 

Internet Explorer 

 When you install SmartHelp and then restart Internet Explorer, a message about the 
SmartHelp add-on appears. Select Enable and then restart Internet Explorer again to 
enable SmartHelp. 
   

 In most cases, after you restart the browser the new toolbar button appears 

automatically. However, if the user has customized the Internet Explorer toolbar, the 
new button may not appear. In this case, the toolbar button is added to the choices in 
the Customize Toolbar dialog box, and it appears if the toolbar is reset. 
   

 Depending on the version of Internet Explorer you are using, the entire toolbar may 

not display. In this case the SmartHelp button is located in the dropdown list area for 
more buttons. 

Firefox 

 In most cases, after you restart the browser the new toolbar button appears 
automatically. However, in some cases the SmartHelp toolbar button must be explicitly 
added to the toolbar using the toolbar’s Customize option. 

   

 SmartHelp can become temporarily disabled if Firefox is just about to upgrade to a 
newer browser version. If SmartHelp is not automatically re-enabled during the next 
two browser restarts, you must re-enable SmartHelp manually from the Tools menu. 

2.4 Administer SmartHelp Groups 
If you deploy SmartHelp content through the Knowledge Center server, you can create 
SmartHelp groups. Using groups can make subscriptions easier. If a user subscribes to a 

group, they are automatically subscribed to all content in the group. If any content is added to 
the group, they are automatically subscribed to that, as well. 
  
You create and administer SmartHelp groups using knowledge paths in Knowledge Center. 
Knowledge paths are used to organize titles into curricula in courses for the users to learn 
about the application. If the titles are enabled for SmartHelp, the knowledge paths become 
SmartHelp groups as well. By enrolling a user in a knowledge path, they are enrolled in the 

SmartHelp group. For more information about knowledge paths in general, see Manage 
Knowledge Paths in the User and Content Management guide. 
  
Note: Knowledge Paths are only available in the Professional Edition of Knowledge Center. 
  
To manage SmartHelp groups, you must have a user account for Knowledge Center with 

Manager rights to allow you to launch the Manager application. The procedures in this section 
assume that you have logged in to Knowledge Center and opened the Manager. For more 
information, see Log In in the Knowledge Center guide. Once you have logged in, click the 
Manager link in the Navigation pane on the left to open Manager. 

2.4.1 Enable Titles for SmartHelp 

Titles in Knowledge Center must be enabled for SmartHelp to use them in groups. Titles are 
enabled for SmartHelp by default; this option appears on the Properties page for the title. You 
can control this in two ways. You can edit the setting on the Properties page for the title, or, in 

the Developer, you can enable or disable the Allow SmartHelp option for the title in the IAS 
Configuration document. When the document is published to Knowledge Center, this setting is 
honored. 
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If the title is enabled for SmartHelp, a URL appears in the Public CDD URL field. If desired, you 

can send this URL to a user to allow them to subscribe to the title directly without using 
groups. 
  

To enable or disable a title for SmartHelp: 

1. In the Manager, display the Title Management page. 

   

2. Click  in the Edit column for the title you want to edit. 

   
3. Scroll to the bottom of the Title Properties page, if necessary, 

   
4. Select or deselect the Enable SmartHelp option. 

   
5. Click Save. 

2.4.2 Create a Group 

A knowledge path is a SmartHelp group, and all of the titles in the knowledge path are part of 
the group. In a knowledge path, titles are associated with activities. To put multiple titles in a 

group, you create multiple activities and associate a title with each activity.  
  
In most cases, you should consider creating specific knowledge paths to use for SmartHelp 
groups instead of re-using ones set up for user learning. If you set up one for user learning, it 
may not result in the SmartHelp group that you want, and, if you want to change the titles in 
the group, it may have adverse effects on user learning. If you create a knowledge path 
specifically to be a SmartHelp group, it is a good idea to make sure that the User Can Self 

Enroll option is deselected so that a user cannot accidentally enroll in it. This option is 
deselected by default. 
  
When you enable a knowledge path for SmartHelp, the Public CDD URL field is automatically 
populated with a URL. This URL can be sent to users to allow them to enroll in the group from 

another location. 

  

Create a SmartHelp Group using an Organizational Knowledge Path 

The simplest way to create a SmartHelp Group is to create an organizational knowledge path. 
This type of path contains multiple activities all at the same level; all activities are at the same 
level. The name of the knowledge path is used as the name of the SmartHelp group. 
  

Example, based on the procedure below: 
  
Knowledge Path Name 

Activity: Title A 
Activity: Title B 
Activity: Title C 

  

To create a SmartHelp group using an organizational knowledge path: 

1. In the Manager, display the Knowledge Path Management page. 
   

2. Click Create path. 
   

3. Enter a name for the path. This is used as the name of the SmartHelp group. 
   

4. Click the Enable SmartHelp option. 
   

5. Click Save. 
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6. Click the Activities link. 
   

7. Click  in the Add column. 

   
8. Click Browse next to the Title Properties field. 

   
9. Expand the hierarchy of items as necessary. 

   
10. Select the desired item. 

   
11. Click Select. 

   

12. Click Save to save the activity. 
   

13. Click Back to Activities. 
  

14. Click  in the Add column on the top line  next to the path name. 

   
15. Repeat steps 8 through 13 for each title you want to add to the group. 

   
16. Click the Properties link to return to the Path Properties page. 

   
17. Click the Back to List link to return to the Knowledge Path Management page. 

Create a SmartHelp Group using a Curriculum Knowledge Path 

A curriculum knowledge path includes multiple activities at different levels. In this type of 
knowledge path, you can essentially create a group with sub-groups. While a user can only 
subscribe to the group itself, by creating sub-groups you can organize a great number of titles 

into sub-groups for easier maintenance. 
  
Example, based on the procedure below: 
  
Knowledge Path Name 

Activity: Title A 
Activity: Title A1 

Activity: Title A2 
Activity: Title B 

Activity: Title B1 
Activity: Title B1-1 
Activity: Title B1-2 

Activity: Title B2 
  

To the users, they simply subscribe to the group (knowledge path) and are subscribed to all of 
the titles. For maintenance, titles can be easier to locate if they are arranged in a hierarchy. 
  

To create a SmartHelp group using a curriculum knowledge path: 

1. In the Manager, display the Knowledge Path Management page. 

  
2. Click Create path. 

  
3. Enter a name for the path. This is used as the name of the SmartHelp group. 

  

4. Click the Enable SmartHelp option. 
  

5. Click Save. 
  

6. Click the Activities link. 
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7. Click  in the Add column. 

  

8. Click Browse next to the Title Properties field. 
  

9. Expand the hierarchy of items as necessary. 
  

10. Select the desired item. 
  

11. Click Select. 
  

12. Click Save to save the activity. 
  

13. Click Back to Activities. 
  

14. Click  in the Add column next to the activity to which you want to add a sub-

activity at a lower level. 

  

15. Repeat steps 8 through 13 as necessary to add titles and create the hierarchy. 
    

16. Click the Properties link to return to the Path Properties page. 
  

17. Click the Back to List link to return to the Knowledge Path Management page. 

SmartHelp Hierarchy 

After you have created a SmartHelp group, you can view the SmartHelp hierarchy. The 

hierarchy may resolve to something that looks a little different than the knowledge path. This 
happens because a title cannot be a group, which is part of the organizational structure, as 
well as a title. In the hierarchy, therefore, you may see the name of the title duplicated as the 
group name. For example, the first example structure, given above for the organizational 
knowledge path, displays this hierarchy: 
  
Group Name 

Title A 
Title B 
Title C 

  
However, the second example structure, given above for the curriculum knowledge path, 
displays this hierarchy: 

  
Group Name 

Title A (Group Name) 
Title A (title name) 
Title A1 
Title A2 

Title B (Group Name) 

Title B (title name) 
Title B1 (Group Name) 

Title B1 (title name) 

Title B1-1 
Title B1-2 

Title B2 
  

To view the SmartHelp hierarchy: 

1. In the Manager, display the Knowledge Path Management page. 
   

2. Click  next to the group for which you want to view the hierarchy. 
   

3. Click the Show SmartHelp Hierarchy link. 
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2.4.3 Enroll Users in a Group 

When you enroll users in a SmartHelp group, the titles then become available for subscription 

the next time the user opens SmartHelp. The user is notified that there are new sources, and 
they can choose to subscribe to the entire group or individual titles on the SmartHelp 
Subscription Home page. 

  
The users must have accounts in Knowledge Center. For more information about users and 
creating accounts, see Manage Users in the User and Content Management guide. You can 
also create user groups in Knowledge center to allow you to enroll multiple users quickly and 
easily in a SmartHelp group. For more information about user groups, see Manage User 
Groups in the User and Content Management guide. 
  

Before performing this procedure, you must have created user accounts in Knowledge Center. 
  

To enroll users in a SmartHelp Group: 

1. In the Manager, display the Knowledge Paths Management page. 

   

2. Click  next to the knowledge path (group name) to which you want to enroll users. 
   

3. Click the User Enrollment link. 
   

4. In the Admin Enrolled column, select the checkboxes next to the users you want to 
enroll in the group. 
  
Note: If you have created user groups in Knowledge Center, you can click the User 
Group Enrollment link in step 3 and select the user groups to enroll in the Enrolled 
column. 

 


